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Spreadsheets: Part 1

You will learn about some important features of 
Excel.

Online MS-Office information source: 
https://support.office.com/

Getting Started: Creating A New Blank SpreadSheet 
(Excel: “Workbook”)

• Once Excel has started, select the option for creating a new 
sheet:

Select this for  

CPSC 203

https://support.office.com/
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Spreadsheets 101 (Basics)

Row 
numbers

Column 
headingsCoordinates of 

current cell

Contents of 
current cell

Current cell

Entering Data

• Click on cell to enter the data (in the example: selected cell A1)

• Type in cell contents (data entered in the example: ‘Student’)
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Contents Of A Cell: Types

• Raw data: also referred to as ‘constants’

• Labels: describe the contents of another cell

• Formula: values derived from the raw data (e.g., calculations: 
=2+2, lookup values: =D2*2, functions: =sum(B2,B9))

Distinguishing Formulas From Text

• In Excel all formulas must be preceded by the ‘=‘ symbol 
(“assignment operator”) to distinguish it from text.

• Example spreadsheet: 1_formulas
– Label

2 + 2

– Formula

= 2 + 2

For the sake of brevity, you can assume that all formulas in this 

section will be preceded by the assignment operator ‘=‘ 
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Entering A Formula That Refers To Another Cell Or Cells

• Approach 1: type it all in all 
– Click on a cell where you want to enter the formula e.g. click on C2

– Type in the formula manually e.g. type =A2*B2

• Approach 2: type and click
– Click on a cell where you want to enter the formula e.g. click on C2

– When you get to the part of the formula that refers to another cell then 
just click on the cell (being referred to) rather than typing in the cell 
address e.g. click on A2 after typing the ‘=‘ in C2

2)  Reference to Cell 
A2 appears here

1) Click 
here

Formatting Cells

• For other information for the other tabs (right clicking on a cell 
to ‘format cells’)
– Similar to the basic features of Word these features will be assumed prior 

knowledge or knowledge that students can pick up on their own.

– These features won’t be covered in lecture nor will they be covered in 
tutorial.

– For more information please refer to the tutorial notes: 
“excel_basic_features”.
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Basic Mathematical Operators

• Example spreadsheet: 2_operators

Mathematical 
operation

Excel operator Example

Assignment = = 888

Addition + = 2 + 2

Subtraction - = 7 – 2

Multiplication * = 3 * 3

Division / = 3 / 4

Exponent ^ = 3 ^ 2

• Operations on a higher level are evaluated first
8 / 2 ^ 3 Equals 8 / 8 or 1

• When a sequence of operators from same level (e.g. addition, 
subtraction) are encountered in a cell the expression is 
evaluated from in order in which they appear (left to right).
2 + 2 - 1 Equals 4 – 1 or 3 

Order Of Operation

Level Operation Symbol

1 Brackets (inner 
before outer)

()

2 Exponent ^

3 Division,
Multiplication, 

/
*

4 Addition, 
Subtraction

+ -

Design rule of thumb: 

use brackets to make 

the ordering explicit.
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Designing Spreadsheets: Rules Of Thumb

1. Use brackets to make ordering clear
– Do this even if order can be determined using the specified rules of 

operation.

• NO

–C1 + C2 * D2 / E2

• YES (brackets help to visually group information as well making ordering clear)

• YES

–C1 + ((C2 * D2) / E2)

Designing Spreadsheets: Rules Of Thumb

2. Do not directly enter values as data that can be derived from 
other values (this is a numerical calculation example)

– Example

• Assignment grade (assume one assignment worth 40%) = 4.2 (data in cell A2)

• Exam grade (assume only one exam worth 60%) = 3.3 (data in cell B2)

• Calculate term grade point =(A2*0.4)+(B2*0.6) OR directly enter 3.66?

4.2 3.3 =(A2*0.4)+(B2*0.6)

A2 B2
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Designing Spreadsheets: Rules Of Thumb

1. Do not directly enter values as data that can be derived from 
other values (the ‘&’ operator connects text)
•Example: 3_generating_honorifics

=A2 & " " & C2

=A2 & " " & B2

In Excel the ampersand ‘&’ 
connects text strings

Manually 

entered 

data

Generated 

(and 

updated) 

according 

to the data

Designing Spreadsheets: Rules Of Thumb

3. Label information so it can be clearly understood
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Designing Spreadsheets: Rules Of Thumb (4)

4. Never enter the same information more than once
Example spreadsheet: 4grades_formulas

• Advantages: reduces size and complexity of the sheet, making changes can be 
easier.

• Seems obvious? Not always

• Example: What if the previous spreadsheet were used to calculate the grades 
for a class full of students?

• Some would create the sheet this way:
=(B2*0.4)+(C2*0.6)

=(B3*0.4)+(C3*0.6)

Etc.

Designing Spreadsheets: Rules Of Thumb (5)

– Issues:

• Making changes: What if the value of each component (40% assignments, 60% 
exams) changed?

–Retyping/modifying all formulas is inefficient (at least a copy-paste is needed)

• Clarity: What does the 0.4 & 0.6 refer to (sometimes it’s not so obvious)? It 
violates the “label information” rule of thumb.

=(B2*0.4)+(C2*0.6)

=(B3*0.4)+(C3*0.6)

Etc.
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Lookup Tables

• Example spreadsheet: 5_grades_lookup

• As the name implies it contains information that needs to be 
referred to (“looked up”) in a part of the spreadsheet.

• Can be used to address some of the issues related to the 
previous example:
– Clarity

– Entering the same data multiple times

=(B2*$G$2)+(C2*$G$3)

Quick Hint #1: When To Use the $ Sign (Absolute Cell 
Reference)

• If a formula always refers to the same location in the spreadsheet (e.g. 
lookup table or lookup cell)

• Always precede references to cells being looked up with a dollar sign

– Values in G2 and G3 are needed in calculations for all students so the row and 
column are preceded by a dollar sign: (B2*$G$2)*(C2*$G$3)

– The dollar signs ensure that when the formula is copy-pasted, other student’s 
term grade points always refers to grade weightings specified in the lookup table 
defined in Cell G2 and Cell G3.

=(B2*$G$2)+(C2*$G$3) Changing the lookup table values 

automatically changes all cells that refer 

to the table (i.e. term GPAs update)
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Quick Hint #2: When NOT To Use the $ Sign (Relative 
Cell Reference)

• If a formula will refer to different cells if it is copy-pasted (or 
moved) to another part of the spreadsheet.
– E.g. assignment and exam GPA used to calculate term grade.

=(B2*$G$2)+(C2*$G$3)Original formula

=(B3*$G$2)+(C3*$G$3)Formula copied 
down 1 row 
(row +1)

Relative Cell Reference: No $ 
Sign

• General rule:
– If the formula is moved/copied ‘down’ by ‘a’ rows then the relative row 

references increases by ‘a’ amount.

• Previous example: formula is copied down by 1 row so the cell references 
increased by 1: from B2 to B3 (+1) for the assignment component and from C2
to C3 (+1) for the exam component.

• Thus the formula changed:

–From: =(B2*$G$2)+(C2*$G$3)

–To: =(B3*$G$2)+(C3*$G$3)

– If the formula is moved/copied ‘up’ by ‘a’ rows then the relative row 
references decreases by ‘a’ amount.

– If the formula is moved/copied ‘left’ by ‘c’ rows then the relative cell 
references decreases by ‘c’ amount.

– If the formula is moved/copied ‘right’ by ‘d’ rows then the relative cell 
references increases by ‘d’ amount.
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Relative Cell Reference: Errors

• If a relative cell reference produces a row or column reference 
outside the valid range (e.g. below ‘A’ or ‘1’) an error message 
will appear.

• Example: copy the relative cell reference from D3 to D1.

– The new formula would refer to Cell =B1 minus two rows (not possible).

• Maximum number of cells in an Excel spreadsheet1

– 1,048,576 rows by 16,384 columns

– (This information is included for your own reference rather than 
something you should know as a requirement for the exam).

1 Source: https://support.office.com/en-us/article/excel-specifications-and-limits-1672b34d-7043-467e-8e27-269d656771c3

Cell References: Example Exam Question

• What’s the result of copying the expression from F3 to G4?

• Note: References to empty cells (e.g. B1) that are used in a 
mathematical expression return 0.
– Example B1 + C1 = 0

https://support.office.com/en-us/article/excel-specifications-and-limits-1672b34d-7043-467e-8e27-269d656771c3
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Data Too Big For Your View

• Covered in this section of lectures notes
– Freezing panes

– Simple merging of cells (merging cells on a single row).

• Covered in the introductory tutorial notes
– Resizing rows or columns

– Wrap the data

– Merge data (merging multiple rows as well as multiple columns)

“Freezing” Panes: How/Why

• Often used to lock the view so labels always stay onscreen 
regardless of which part of the sheet you are viewing.

• Obviously this is useful for cases that contain column (or row) 
headings.

• Running the Freeze Panes feature: View -> Window: 
Freeze Panes
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Freezing Panes: Effect On Example Spreadsheet

Freeze Panes: Procedure

• Move to the row below the row to be ‘frozen’.

• In the previous example with student grades it would be Row 
3.

• Select: 
– View -> Window : Freeze Panes and then select the “Freeze 
Pane” option among the options.
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Merging The Columns Along A Single Row

• Combines the columns into one wider column.

• Before the merge

• (Merging Row 1: Col A – E)

• After “Merge & Center” (merge and center align)

• After the Merge Across, Merge Cells (merge and retain 
previous  alignment settings)

Merge Columns (Each Containing Data)

• Only the data in the top left-most cell of the merged range is 
retained.

• Before the merge.

• After the merge: Merge and center (“L01” is lost)

• After the merge: Merge across, Merge cells (data “L01” is lost)
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Copy-Paste: Explanation

• A single cell or a range of cells can be copied (or cut) and 
pasted.

• There are a number of options for how the originating cell or 
cell is pasted into the new location.

• We will cover a few of the options for this class
– “Paste”: copies the formula (which may be modified if the cell references 

are relative)

• May update final values if the data changes (relative references used).

– “Paste values”: includes only data or the final result of a formula. 

• If the formula changes then the pasted data won’t be updated.

– “Paste link”(always updates to the current value in the source cell)

Copy-Paste: Example

• Example spreadsheet: 6_copy_paste
– Copy paste from A3 into C3 (paste current formula), D3 (paste current 

data), D3 (paste link)

– Changes in data in the source cell: if the values in A5 & B5 change to 9
and 6 respectively what will the values be in C3, D3, E3 and why.

– Changes in the formula in the source cell: Contents of A3 was changed to  
=9*3

=$A$5*$B$5

=$A$5*$B$5
56 =$A$3
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Copy-Paste

• For your information: Multiple cells (an entire row, column or 
even a range of cells e.g. A1:C10 can by copied-pasted)

Autofill

• Allows for a sequence (constant or addition by a constant 
amount) to be extended
– E.g., The sequence “1, 2, 3” (can be extended to include “…4, 5, 6”)

• Steps:
1. Highlight the cells containing the sequence to extend (selecting one cell 

just repeats the contents of that one cell).

2. Move the mouse pointer to the ‘handle’ at the bottom right
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Autofill (2)

3. Drag the mouse as far down as you wish the sequence to be extended 
to.

Autofill (3)

• It’s best to only extend a sequence that only employs addition 
(e.g. +1, +3, -1, -10) or a constant sequence using autofill 
handles.

• To extrapolate other sequences (e.g. multiplication) don’t use 
autofill:
– https://support.office.com/en-us/article/project-values-in-a-series-

5311f5cf-149e-4d06-81dd-5aaad87e5400

https://support.office.com/en-us/article/project-values-in-a-series-5311f5cf-149e-4d06-81dd-5aaad87e5400
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Autofill: Practice

• What would be the autofill result of the following.

E.g.1 E.g. 2

Terminology

• Spreadsheet (referred to as a “workbook” by Microsoft)
– A Microsoft Excel file

• Worksheet
– A part of a spreadsheet
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• Each spreadsheet can consist of multiple worksheets.

– Example:
• Spreadsheet: all my CPSC 203 grades for the CPSC 203 fall 2008 term.

• Worksheets for each of the two lectures taught by this instructor that term.

Worksheets

Worksheet

Spreadsheet

Create new 

worksheet

When To Use Multiple Worksheets

• Rules of thumb:
– When there are multiple sheets of related information, each group of 

information can be stored in it’s own worksheet (self contained)

Grades for lecture 01

(worksheet)

Grades for lecture 02

(worksheet)

Grades for lecture 03

(worksheet)

Grades for all sections(spreadsheet)

Budget for dad 

(worksheet)
Budget for mom

(worksheet)

Budget for sunny-boy

(worksheet)

Family budget (spreadsheet)
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When Not To Use Multiple Worksheets 

• If the information consists of groups of unrelated information 
then the information about each group should be stored in a 
separate spreadsheet/workbook rather than implementing it a 
spreadsheet with multiple worksheets.

Grades for 

mom 

(spreadsheet)

Expenses for 

the family 

business 

(spreadsheet)

Daily calorie 

intake for dad 

(spreadsheet)

Referring To Other Worksheets

• One worksheet can refer to information stored in another 
worksheet.

• Example spreadsheet:
– 7_multiple_worksheet_example

JT’s tip:
• For more complex examples you might 

want to take extra “in-class” notes.
• (It could be hard to understand the 

concepts at a level sufficient for the exam 
or remember notation/symbols if you just 
look at the slides).
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References Between Spreadsheets

• In a fashion similar to using multiple worksheets, one 
spreadsheet can refer to information stored in another 
spreadsheet.

• Example spreadsheets:
– 8A_multiple_spreadsheet_example

– 8B_multiple_spreadsheet_example

=A2*'[8B_multiple_spreadsheet_example.xlsx]AB rates'!$A$2

8A 8B
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Why Use Cross References?

• Cross references:
– a worksheet refers to another worksheet,

– a spreadsheet refers to another spreadsheet,

• …may be used when:
– the second worksheet or spreadsheet contains data 

that needs to be “looked up” (e.g., a lookup table)

• Some examples where cross reference 
lookups may be needed:
– Grade cutoffs

– Tax brackets

– Product numbers (lookup a product number to get 
more information about the product)

Data Validation

• Ensures that the data falls within a valid range (e.g. Age must 
be 0 – 116) or that a specific type of data is entered (e.g. whole 
number only).

• Invoking:
– Data->Data Tools: Data Validation

• Example spreadsheet: 9_data_validation
– Name: no restrictions e.g. “James Tam”, “James Tam  2”, “James 
Goldstein-Chan” “James.org”

– Age: number years (whole number) from 1 – 116

– Income: can include any value from $0.00 - $1,000,000.00 (cents can be 
entered)

– Make sure you include good error messages when setting up data 
validation rules..

• Tell the user what range of values and/or the type of values that can be entered.
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Data Validation Example: Name

• No restrictions on input (this is the default in Excel)

Data Validation Example: Age

• Age must be a whole 
number from 1 – 116.

• Tools to prevent errors in 
input
– Restricting the input

– Tooltip help before data 
entry
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Data Validation Example: Age

• A tool to react after bad data 
has been entered.
– Popup error message appears 

after the input restrictions have 
not been met.

Data Validation Example: Income

• Income allow for any value from $0.00 - $1,000,000.00 (cents 
may be entered – this is a clue that the input should not be 
restricted only to whole numbers).
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After This Section You Should Now Know

• The benefit of electronic over paper spreadsheets

• Spreadsheets 101: The basic layout and components of a 
spreadsheet

• Entering data: manually and via autofill

• Raw data vs. labels vs. formulas
– How formulas are distinguished from text

– Specifying formulas that refer to other cells

• Formatting cells

• Common mathematical operators and the order of operation

• The rules of thumb for designing spreadsheets
1.Bracket everything

2.Don’t make something data if it can be derived

3.Label everything so it can be understood

4.Don’t duplicate data

After This Section You Should Now Know (2)

• Lookup tables
– How to create and use a lookup table

– Includes lookup tables with constant values and lookup tables to be used 
in conjunction with lookup function

• When to use absolute vs. relative cell references in formulas
– How do formulas using absolute vs. cell references change when copied 

elsewhere

• Ways of changing views when the data is too large for the 
display
– Freezing panes

– Merging cells
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After This Section You Should Now Know (3)

• Different forms of copy paste: 
– Paste

– Paste values

– Paste link

• What is a worksheet
– When to use multiple spreadsheets vs. multiple worksheets

– How to reference data in other spreadsheets or worksheets (cross 
references)

• How to prevent errors using data validation

Images

• “Unless otherwise indicated, all images were produced by 
James Tam
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